
Pro/ENGINEER® 2001

Pro/PHOTORENDER����
Themensammlung

Parametric Technology Corporation



Copyright © 2000 Parametric Technology Corporation. Alle Rechte vorbehalten.
Die Benutzerdokumentation der Parametric Technology Corporation (PTC) unterliegt den Urheberrechten der
Vereinigten Staaten und anderer Staaten sowie einem Lizenzvertrag, der die Vervielfältigung, Veröffentlichung und
Verwendung besagter Dokumentation einschränkt. PTC gewährt dem lizenzierten Benutzer hiermit das Recht, die
auf Software- oder Dokumentationsdatenträgern bereitgestellte PTC Benutzerdokumentation in gedruckter Form
zu vervielfältigen, jedoch ausschließlich für den internen, nicht kommerziellen Gebrauch durch den lizenzierten
Benutzer und in Übereinstimmung mit dem Lizenzvertrag, unter dem die jeweilige Software und die
Dokumentation lizenziert sind. Jede unter den obigen Bedingungen hergestellte Kopie enthält den
urheberrechtlichen Hinweis der Parametric Technology Corporation und sonstige von PTC bereitgestellte
proprietäre Hinweise. Benutzerdokumentation darf ohne vorherige schriftliche Genehmigung der Parametric
Technology Corporation (PTC) nicht veröffentlicht, weitergegeben oder auf irgendeine Weise geändert werden, und
es wird keine Berechtigung zum Herstellen von Kopien zu solchen Zwecken erteilt.

Die im vorliegenden Handbuch zur Verfügung gestellten Informationen dienen nur zur Information; sie können
ohne vorherige Ankündigung geändert werden und enthalten keinerlei Garantien oder Verpflichtungen von Seiten
der Parametric Technology Corporation.  PTC übernimmt keine Verantwortung oder Haftung für etwaige Fehler
oder Ungenauigkeiten, die unter Umständen in diesem Dokument auftreten.

Die im vorliegenden Handbuch beschriebene Software ist nur mit einem schriftlichen Lizenzvertrag erhältlich;
sie enthält wertvolle Betriebsgeheimnisse und Eigentumsinformationen, die unter den Urheberrechten der
Vereinigten Staaten und den Urheberrechten anderer Staaten geschützt sind. DIE UNBERECHTIGTE
VERWENDUNG DER SOFTWARE ODER DER DAZUGEHÖRIGEN DOKUMENTATION KANN
SCHADENERSATZFORDERUNGEN ZUR FOLGE HABEN ODER ZU STRAFRECHTLICHER
VERFOLGUNG FÜHREN.

Eingetragene Warenzeichen der Parametric Technology Corporation oder einer Tochterfirma
Advanced Surface Design, CADDS, CADDShade, Computervision, Computervision Services, dVISE,
Electronic Product Definition, EPD, HARNESSDESIGN, Info*Engine, InPart, MEDUSA, Optegra,
Parametric Technology Corporation, Pro/ENGINEER, Pro/INTRALINK, Pro/MECHANICA, Pro/TOOLKIT,
PTC, PT/Products und Windchill.

Warenzeichen der Parametric Technology Corporation oder einer Tochterfirma
3DPAINT, Associative Topology Bus, Behavioral Modeler, CDRS, CV, CVact, CVaec, CVdesign, CV-DORS,
CVMAC, CVNC, CVToolmaker, DesignSuite, DIMENSION III, DIVISION, DIVISION EchoCast,
dVSAFEWORK, dVS, e-Series, EDE, e/ENGINEER, Electrical Design Entry, EPD.Connect, EPD Roles,
EPD.Visualizer, Expert Machinist, Expert Toolmaker, Flexible Engineering, i-Series, ICEM, ICEM DDN, ICEM
Surf, Import Data Doctor, Information for Innovation, ISSM, MEDEA, ModelCHECK, NC Builder, Parametric
Technology, Pro/ANIMATE, Pro/ASSEMBLY, Pro/CABLING, Pro/CASTING, Pro/CDT, Pro/COMPOSITE,
Pro/CMM, Pro/CONVERT, Pro/DATA for PDGS, Pro/DESIGNER, Pro/DESKTOP, Pro/DETAIL,
Pro/DIAGRAM, Pro/DIEFACE, Pro/DRAW, Pro/ECAD, Pro/ENGINE, Pro/FEATURE, Pro/FEM-POST,
Pro/FLY-THROUGH, Pro/HARNESS-MFG, Pro/INTERFACE for CADDS 5, Pro/INTERFACE for CATIA,
Pro/INTRALINK Web Client, Pro/LANGUAGE, Pro/LEGACY, Pro/LIBRARYACCESS, Pro/MESH,
Pro/Model.View, Pro/MOLDESIGN, Pro/NC-ADVANCED, Pro/NC-CHECK, Pro/NC-MILL, Pro/NC-
SHEETMETAL, Pro/NC-TURN, Pro/NC-WEDM, Pro/NC-Wire EDM, Pro/NCPOST, Pro/NETWORK
ANIMATOR, Pro/NOTEBOOK, Pro/PDM, Pro/PHOTORENDER, Pro/PHOTORENDER TEXTURE LIBRARY,
Pro/PIPING, Pro/PLASTIC ADVISOR, Pro/PLOT, Pro/POWER DESIGN, Pro/PROCESS, Pro/REFLEX,
Pro/REPORT, Pro/REVIEW, Pro/SCAN-TOOLS, Pro/SHEETMETAL, Pro/SURFACE, Pro/VERIFY,
Pro/Web.Link, Pro/Web.Publish, Pro/WELDING, Product Structure Navigator, PTC i-Series, Shaping
Innovation, Shrinkwrap, Virtual Design Environment, Windchill e-Series, Windchill Factor, Windchill Factor e-
Series, Windchill Information Modeler, das PTC Logo, das CV-Computervision Logo, das DIVISION Logo, das
ICEM Logo, das InPart Logo und das Pro/REFLEX Logo

Warenzeichen von Drittparteien
Oracle ist ein eingetragenes Warenzeichen der Oracle Corporation. Windows und Windows NT sind
eingetragene Warenzeichen der Microsoft Corporation. CATIA ist ein eingetragenes Warenzeichen von
Dassault Systems. PDGS ist ein eingetragenes Warenzeichen der Ford Motor Company. SAP und R/3 sind
eingetragene Warenzeichen der SAP AG Deutschland. FLEXlm ist ein eingetragenes Warenzeichen von
Globetrotter Software Inc. VisTools library ist urheberrechtlich geschützte Software von Visual Kinematics Inc.
(VKI), die Betriebsgeheimnisse von VKI enthält. HOOPS Graphics System ist ein propietäres Software-Produkt
von Tech Soft America, Inc., für das Tech Soft America, Inc. die Urheberrechte besitzt. Alle sonstigen Marken-
oder Produktnamen sind Warenzeichen oder eingetragene Warenzeichen ihrer jeweiligen Eigentümer.



EINGESCHRÄNKTE RECHTE VON US-BEHÖRDEN
Im Sinne der Gesetze und Regelungen der Vereinigten Staaten, namentlich FAR 12.212(a)-(b) sowie DFARS
227.7202-1(a) und 227.7202-3(a), gilt die vorliegende Dokumentation als Dokumentation für kommerzielle
Computersoftware, und die dazugehörende Software gilt als kommerzielle Computersoftware, die Behörden
und amtlichen Stellen gemäß dieser Gesetze und Regelungen zur Verfügung gestellt wird. Jegliche Nutzung
des Produkts unterliegt einer kommerziellen, nichtausschließlichen Lizenz. Bei Beschaffungen vor Eintritt der
genannten Bestimmungen unterliegt die Nutzung, Vervielfältigung und Veröffentlichung durch Behörden und
amtliche Stellen den Bestimmungen von Unterabsatz (c)(1)(ii) der Rechte an technischen Daten und
Computersoftware gemäß DFARS 252.227-7013 bzw. der Eingeschränkten Rechte an kommerzieller
Computersoftware gemäß FAR 52.227-19.

Parametric Technology Corporation, 128 Technology Drive, Waltham, MA 02453-8905 6. September
2000





Pro/PHOTORENDER 5

Inhaltsverzeichnis

Render-Einstellungen.......................................................................................... 9

So legen Sie Optionen in config.pro fest .......................................................... 9

Render-Konfiguration........................................................................................ 10

So bearbeiten Sie die Registerkarte "Optionen" im Dialogfenster "Render-
Konfiguration" ................................................................................................... 10

So bearbeiten Sie die Registerkarte "Einstellung" im Dialogfenster
"Render-Konfiguration" .................................................................................... 11

So bearbeiten Sie die Registerkarte "Config" im Dialogfenster "Render-
Konfiguration" ................................................................................................... 12

Farbeffekte ......................................................................................................... 13

So erzeugen Sie Farben für Farbeffekte.......................................................... 14

So ändern Sie Farbeffekte vom Modell............................................................ 14

Tip: Farbeffekte erzeugen................................................................................. 14

Farbeffekte-Editor.............................................................................................. 15

So bearbeiten Sie die Farbeffekt-Optionen über die Registerkarte
"Einfach" ............................................................................................................ 15

So bearbeiten Sie die Farbeffekt-Optionen über die Registerkarte
"Spezial" ............................................................................................................. 15

So bearbeiten Sie die Farbeffekt-Optionen über die Registerkarte
"Detail"................................................................................................................ 16

So können Sie Farben erzeugen und bearbeiten ........................................... 16

So wenden Sie Farbeffekte auf das Modell an................................................ 16

So speichern Sie Materialdateien..................................................................... 17

So entfernen Sie Farbeffekte aus dem Modell ................................................ 17

Allgemeine Einführung: Lichtquellen.............................................................. 17

So verwenden Sie das Dialogfenster Lichtquellen (Lights) .......................... 18



Pro/PHOTORENDER6

So erzeugen Sie Lichtquellen........................................................................... 19

Definition der Lichtquellen ............................................................................... 19

So ändern Sie Lichtquellen............................................................................... 20

So löschen Sie Lichtquellen............................................................................. 20

So öffnen Sie Lichtquellen-Dateien ................................................................. 20

So speichern Sie Lichtquellen-Dateien ........................................................... 20

Raum................................................................................................................... 20

So erzeugen Sie Räume.................................................................................... 21

Tip: Darstellung mit schattierten Wänden....................................................... 21

Tip: Raum erzeugen .......................................................................................... 21

So legen Sie ein Raumraster fest..................................................................... 22

So wenden Sie Texturen auf Räume an........................................................... 22

So öffnen Sie Räume......................................................................................... 22

So speichern Sie Räume................................................................................... 22

So ändern Sie perspektivische Ansichten ...................................................... 22

Benutzeroberfläche für das Rendern............................................................... 23

So rendern Sie Modelle ..................................................................................... 24

Schattierte Modelle............................................................................................ 24

Bilder speichern................................................................................................. 24

So bearbeiten Sie Bilder ................................................................................... 25

Bildoptionen....................................................................................................... 25

So verwenden Sie das Dialogfenster Dia-Show (Slide Show)....................... 26

So ändern Sie die Orientierung........................................................................ 27

Terminologie für Rendering.............................................................................. 27

Texturen.............................................................................................................. 32



Pro/PHOTORENDER 7

Texturen speichern............................................................................................ 33

So erzeugen Sie Texturen anhand von Farbeffekten..................................... 33

So plazieren Sie Texturen................................................................................. 34

So entfernen Sie Texturen ................................................................................ 35





Pro/PHOTORENDER 9

Render-Einstellungen
Beim Einstellen von Renderings können Sie die Optionen in ÅçåÑáÖKéêç definieren sowie das
Dialogfenster Render-Konfiguration (Render Configuration) zur Anpassung der Renderings einsetzen.
Als Vorbereitung auf das Rendern können Sie außerdem Farbeffekte auf das Modell anwenden, einen
Rendering-Raum erzeugen sowie Lichtquellen definieren.

So legen Sie Optionen in config.pro fest
Setzen Sie die PhotoRender-Optionen, indem Sie die Datei ÅçåÑáÖKéêç bearbeiten. In der
nachstehenden Tabelle werden die verfügbaren Optionen aufgeführt.

Name der Option Wert Beschreibung

maximum_texture_size 64x64
128x128
256x256
512x512

Nur bei Hardware-Darstellung. Falls
eine Grafikkarte mit begrenztem
Speicher für Texturen vorliegt,
werden kleinere Texturmuster
verwendet. Die Voreinstellung
entspricht dem maximalen Wert, der
von der Grafikkarte unterstützt wird.

pro_colormap_path Gültiger Pfad Benutzerdefinierter Suchpfad für
Farbzuordnungsdateien.

photorender_preview_scale 0,25 bis 1,0 Benutzerdefinierter Maßstab, in dem
Bilder in PhotoRender gerendert
werden, wobei die
Vorgabeeinstellung Render To: Full
Window Preview verwendet wird.
Durch Anheben des Werts wird die
Qualitaet des gerenderten Bildes
erhoeht und die Leistung
vermindert. Das Vermindern des
Werts hat den gegenteiligen Effekt.
Vorgabe: 0.5.

photorender_default_width Begrenzt durch das
verfügbare
Hardware-RAM.

Ändert die RAM-Variable, die
PhotoRender für die Erstellung des
horizontalen Aspekt des Bildes
zuteilt. Durch Anheben des Werts
der Variable werden Bilder schneller
gerendert, wobei mehr an Hardware
RAM benutzt wird, wodurch
wiederum andere Prozesse
verlangsamt werden.

photorender_default_height Begrenzt durch das
verfügbare
Hardware-RAM.

Ändert die RAM-Variable, die
PhotoRender für die Erstellung des
vertikalen Aspekt des Bildes zuteilt.
Durch Anheben des Werts der
Variable werden Bilder schneller
gerendert, wobei mehr an Hardware
RAM benutzt wird, wodurch
wiederum andere Prozesse
verlangsamt werden.
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photorender_polygon_limit 100.000 bis 5.000.000 Bestimmt die Anzahl der
Modellpolygone, die von
PhotoRender maximal verarbeitet
werden können. Standardmäßig
nicht genutzt.

photorender_timeout Keine Einschränkung Bestimmt die Zeitgrenze für das
Rendering. Bei einem Zeitueberlauf
wird der Prozess stillgelegt.
Vorgabe: 60 min.

photorender_shared_mem
_filename

Gültiger Pfad Vorgabe: /usr/tmp/PR_mpxxxayyy
(nur bei SGI).

pro_texture_library Gültiger Pfad Ermoeglicht dem Benutzer, eine
andere Graphics-Bibliothek
anzugeben. Die Graphics-Bibliothek
befindet sich beispielsweise in
C:\ptc\graphiclib\graphic-library.
Setzen Sie
éêç|íÉñíìêÉ|äáÄê~êó auf
`WyéíÅyÖê~éÜáÅäáÄ.

texture_search_path Gültiger Pfad Haengt an den Suchpfad fuer
Texturen ein Verzeichnis an. Sie
können mehrere Verzeichnisse
angeben.

photorender_max_shared
_mem_size

Begrenzt durch das
verfügbare
Hardware-RAM.

Nur bei SGI. Weist den gemeinsam
genutzten Speicher zu.

photorender_memory_usage Begrenzt durch das
verfügbare
Hardware-RAM.

Bestimmt die RAM-Variable für
PhotoRender.

Render-Konfiguration

Klicken Sie auf die Schaltfläche Konfiguration (Configuration) .

Das Dialogfenster Render-Konfiguration (Render Configuration) enthält drei Register:
� Options (Options) — Steuerung der zu rendernden Elemente, Festlegung der Gesamtqualität für das

Rendering.

� Setup (Setup) — Definition des Formats für die Rendering-Ausgabe.

� Config (Config) — Spezielle Optionen für die Speicherbelegung beim Rendern.

So bearbeiten Sie die Registerkarte "Optionen" im
Dialogfenster "Render-Konfiguration"
Mit dem Register Optionen (Options) im Dialogfenster Rendering-Konfiguration können Sie die zu
rendernden Elemente festlegen und die allgemeine Renderingqualität steuern.

� Renderqualitaet (Render Quality) — Steuert die Qualität für das Flächen-Rendern in Modellen. Eine
höhere Qualität führt zu einem erhöhten Zeitbedarf bei der Erzeugung des gerenderten Bildes.

� Texturschaerfe (Texture Clarity) — In der Regel verwenden Sie hier die Option Normal (wenn das
Kontrollkästchen Geometrische Textur schaerfen (Geometric Texture Sharpen) aktiviert wurde).
Mit der Einstellung Hoch (High) wird die Darstellung von stark verschwommenen Wandmustern
verschärft; allerdings kann Aliasing auftreten (also "Treppen" in den Kanten).



Pro/PHOTORENDER 11

Wandmuster werden unscharf, wenn der Winkel zwischen dem Muster und dem Blickpunkt zu klein ist.

� Glanzlicht-Aufloesung (Highlight Resolution) — Bei der Einstellung Normal werden Glanzlichter
schneller gerendert, erscheinen jedoch "winklig". Mit der Einstellung Hoch (High) werden die
Glanzlichter geglättet; hierdurch erhöht sich allerdings der Zeitaufwand für das Rendern.

� Modell (Model) — Umfaßt die folgenden Optionen:

� Transparenz (Transparency) — Rendert die angegebenen Flächen als "transparent"
(beispielsweise Glas). Ansonsten werden transparente Flächen "undurchsichtig" gerendert. Mit
dem Farbeffekte-Editor (Appearance Editor) bestimmen Sie den Grad der Transparenz.

� Texturen (Textures) — Rendert Texturen, die auf Flächen angewandt wurden. Falls keine
Flächentexturen zugewiesen wurden, ist diese Option irrelevant. Die Voreinstellung lautet Aus

(Off), so daß die anfänglichen Renderings mit großer Geschwindigkeit durchgeführt werden
können.

� Eigenschatten (Self Shadows) — Wirft Schatten von den Objekten in einer Szene auf die Objekte
selbst und auf andere Objekte; auf den Boden und die Wände der Umgebung werden keine
Schatten geworfen. Schatten werden nur dargestellt, wenn die Option Schatten werfen bei
mindestens einer der definierten Lichtquellen aktiviert ist.

� Reflexionen (Reflections) — Bestimmt das Reflexionsvermögen der Flächen im Modell.

� Raum (Room) — Umfaßt die folgenden Optionen:

� Raum rendern (Render Room) — Mit dieser Option werden das Modell und die Wandmuster
gerendert. Wenn Sie diese Option deaktivieren, wird lediglich das Modell gerendert. Die
Wandmuster werden allerdings weiterhin auf den Flächen im Modell reflektiert.

� Reflexion auf Boden (Reflect in Floor) — Mit dieser Option wird das Modell auf den Boden
reflektiert, so daß der Boden "glänzt". Dies führt allerdings zu einem erhöhten Zeitaufwand für das
Rendern. Wenn Sie diese Option deaktivieren, wird der Boden matt dargestellt.

� Schatten auf Boden (Shadows on Floor) — Mit dieser Option können Sie die Schatten aktivieren
und wieder deaktivieren. Diese Option kann nur dann zum Werfen von Schatten eingesetzt werden,
wenn die Option Schatten werfen (Cast Shadow) bei einer oder mehreren Lichtquellen aktiviert
ist.

� Geometrische Textur schaerfen (Geometric Texture Sharpen) — Mit dieser Option werden die
geometrischen Wandmuster mit größerer Schärfe gerendert. Diese Option muß unter Umständen
eingesetzt werden, wenn der Boden oder die Wände relativ groß sind. Geometrische Muster sind
beispielsweise Streifen oder Karos.

� Lichtquellen (Lights) — Mit dieser Option können Sie die Standard-Lichtquellen aktivieren und
deaktivieren.

So bearbeiten Sie die Registerkarte "Einstellung"
im Dialogfenster "Render-Konfiguration"
Mit dem Register Einstellung (Setup) im Dialogfenster Render-Konfiguration (Render Configuration)

bestimmen Sie das Format für die Rendering-Ausgabe. Wenn Sie einen Dateityp in das Feld Render-

Ausgabe in (Render To) eingeben, wird das entsprechende Gruppenfeld für den Dateityp geöffnet, und
Sie können beispielsweise das Format und die Größe festlegen.

� Ausgabe > Render-Ausgabe in (Output > Render To) — Mit dieser Option lassen Sie Bilder in ein
Fenster oder eine Datei rendern. Wenn Sie eine Datei-Option wählen, können Sie einen Dateinamen in
das Feld Dateiname (File Name) eingeben. Darüber hinaus können Sie das Ausgabeformat und die
Größe angeben. Es stehen die folgenden Befehle zur Auswahl:

� Volles Fenster (Vorschau) (Full Window (Preview)) — Bilder schnell rendern (niedrige
Qualität, jedoch hohe Geschwindigkeit).

� Volles Fenster (Full Window) — Bild im aktuellen Fenster erzeugen.

� Neues Fenster (New Window) — Bild in einem neuen Fenster erzeugen.

� CDRS Dateien (CDRS File) — KáãÑ-Datei im CDRS-Format.
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� TIFF — TIFF-Format (Tagged Image File Format).

� TGA — TGA-Bildformat (Bildformat von True Vision).

� Shima-Seiki — Shima-Seiki-Bildformat.

� RGB — Bildformat von Silbutton Graphics Inc.

� JPEG — JPEG-Bildformat.

� RLA — Wavefront-Format.

� Postscript — Datei für den Ausdruck auf Postscript-Drucker erzeugen.

� Bildgroesse (Image Size) — Mit dieser Option ändern Sie die Größe sowie das Verhältnis von Breite
und Höhe. Die folgenden Optionen stehen für die Größe zur Verfügung:

� MPEG — Bild mit 352 x 240 Pixel gemäß der MPEG-Standards erzeugen.

� 600 x 450 — Bild mit 600 x 450 Pixel bei einem Pixelverhältnis von 1:1 erzeugen.

� VGA — Bild mit 640 x 480 Pixel gemäß der VGA-Standards erzeugen.

� NTSC — Bild mit 720 x 483 Pixel gemäß der NTSC-Standards erzeugen.

� PAL — Bild mit 720 x 575 Pixel gemäß der PAL-Standards erzeugen.

� 1024 x 1024 (1024-square) — Bild mit 1024 x 1024 Pixel bei einem Pixelverhältnis von 1:1
erzeugen.

� Workstation — Bild mit 1024 x 1240 Pixel erzeugen.

� HDTV — Bild erzeugen, dessen Größe den 240M-HDTV-Standards der SMPTE entspricht.

� HDTV (Shima Seiki) (HDTV (Shima Seiki)) — Bild erzeugen, dessen Größe den HDTV-
Standards von Shima Seiki entspricht.

� Custom Size (Custom Size) — Zur Erzeugung von Bildern mit benutzerdefinierter Größe. Wenn
ein Bild weniger als 1024 x 1024 Pixel umfaßt, muß die Bemaßung in x-Richtung ein Vielfaches
von 32 sein, die y-Bemaßung dagegen ein Vielfaches von 4. Ungültige Werte werden automatisch
auf die nächstliegende gültige Größe gerundet. Die maximale Größe für x und y beträgt 214
(16.384 Pixel).

� Postscript — Mit dieser Option können Sie Postscript-Formate für die Bilder angeben. Die folgenden
Optionen stehen zur Verfügung:

� DPI — Anzahl der Punkte pro Inch im Bild.

� Papierformat (PaperSize) —Wählen Sie ein Standard-Papierformat oder ein benutzerdefiniertes
Format.

� Einheiten (Units) — Bestimmt die Einheiten für die Berechnung des Papierformats bei
benutzerdefiniertem Postscript.

� Breite (Width) und Hoehe (Height) — Breite und Höhe des Papiers.

� Linker Rand (Left Margin) und Oberer Rand (Top Margin) — Linker und oberer Papierrand.

So bearbeiten Sie die Registerkarte "Config" im
Dialogfenster "Render-Konfiguration"
Mit dem Register Config (Config) im Dialogfenster Render-Konfiguration (Render Configuration)

legen Sie spezielle Rendering-Optionen fest, mit denen der Speicherbedarf beim Rendern bestimmt wird.

� Ausgeben (Output) — Mit der Option Alpha lassen Sie den Alphakanal in das Bild schreiben. Der
Alphakanal wird beim Zusammensetzen des Bildes mit einem Hintergrund eingesetzt.

� Groesse der PhotoRender-Kacheln (PhotoRender Tile Size) — Umfaßt die folgenden Optionen:

� Kachelgroesse berechnen (Compute Tile Size) — Die Kachelgröße für das Rendering wird
anhand der Modellgröße und dem Wert unter Verfuegbarer Speicher (Available Memory)

berechnet.
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� Kachelgroesse uebergehen (Override Tile Size) — Geben Sie die Breite oder die Höhe der
Kacheln für die einzelnen Läufe an. Der Speicherbedarf richtet sich nach der vorgegebenen
Kachelgröße. Bei kleineren Kacheln ist der Speicherbedarf geringer, bei großen Kacheln
entsprechend höher.

� Verfuegbarer Speicher (Available Memory) — Bestimmt die Speichermenge, die während des
Rendering maximal zur Verfügung steht. Die empfohlene Einstellung entspricht dem
Arbeitsspeicher der Maschine, auf der PhotoRender ausgeführt wird.

� Kachelbreite pro Durchlauf (Tile width per pass) — Bestimmt die Größe des Bildausschnitts,
der in den einzelnen Läufen gerendert wird. Je größer Wert, desto höher ist der Speicherbedarf und
desto schneller wird das Rendering vorgenommen. Geben Sie den Wert (in Pixel) als Vielfaches
von 4 ein.

� Kachelhoehe pro Durchlauf (Tile height per pass) — Bestimmt die Größe des Bildausschnitts,
der in den einzelnen Läufen gerendert wird. Je größer Wert, desto höher ist der Speicherbedarf und
desto schneller wird das Rendering vorgenommen. Geben Sie den Wert (in Pixel) als Vielfaches
von 4 ein.

� Rendering-Timeout (Rendering Time Out) — Bilder werden in einem oder mehreren Läufen
gerendert. Die Anzahl der notwendigen Läufe ist abhängig von der Komplexität des Renderings und der
Bildgröße. Mit Rendering-Timeout (Rendering Time Out) bestimmen Sie die zulässige Zeitspanne
für die einzelnen Rendering-Läufe; nach Ablauf dieser Zeitspanne wird der Rendering-Vorgang
abgebrochen.

� Darstellen (Display) — Legt den Maßstab des Vorschaubilds als Prozentsatz der tatsächlichen
Bildgröße fest. Bei niedrigeren Werten ist der Zeitbedarf für das Rendering geringer; das Bild ist jedoch
verschwommen. Bei höheren Werten ist das Bild schärfer, das Rendering nimmt allerdings mehr Zeit in
Anspruch.

Farbeffekte
Sie können den einzelnen Teilen und Baugruppen eine Farbe zuweisen. Falls Sie die Farbeffekte nicht
ändern, wird eine Standardfarbe zugeordnet. Farben können durch Festlegen ihres Anteils an FSH (Tönung,
Sättigung, Farbwert) und RGB (Rot, Grün, Blau) definiert werden. Darüber hinaus können die Farbeffekte
die folgenden Angaben enthalten:

� Reflexion

� Glanzlichter

� Transparenz

� Texturen

Zur Definition eines Farbeffekts verwenden Sie die Farbe und/oder die Textur. Definieren Sie
beispielsweise einen Farbeffekt mit einer Farbe, die von einem teilweise transparenten Decal überlagert
wird; an den transparenten Stellen ist die darunter liegende Farbe sichtbar.

Lassen Sie die Farbeffekte in der Farbeffekte-Palette anhand von Farb-Referenzmustern (schnellstes
Verfahren) oder von gerenderten Kugeln darstellen (langsamer). Klicken Sie hierzu auf die entsprechende
Option unterhalb der Palette. Zur Aktualisierung der noch nicht gerenderten Einträge in der Farbeffekte-
Palette klicken Sie mit der mittleren Maustaste auf die gerenderten Muster-Kugeln.

Farbeffekte werden zusammen mit dem Modell gespeichert; beim Laden des Modells werden die
Farbeffekte allerdings nicht berücksichtigt. Sie können eine gespeicherte Farbeffekte-Datei laden, die
Modell-Farbpaletten mit dem Befehl Vom Modell aendern (Modify from Model) zur Palette hinzufügen
oder auch die Farbeffekte-Datei unter éêç|Åçäçêã~é|é~íÜ in der Datei ÅçåÑáÖKéêç als
Standarddatei für die Pro/ENGINEER-Sitzungen festlegen.
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So erzeugen Sie Farben für Farbeffekte
Farbeffekte werden anhand von Farben und/oder Texturen definiert. Mit der Farbeffekte-Palette können Sie
Farbeffekte definieren und bearbeiten sowie den aktiven Farbeffekt für gesamte Teile bzw. für Flächen,
Sammelflächen oder Bezugskurven festlegen.

1. Klicken Sie auf die Schaltfläche Farbeffekt (Appearance) , oder wählen Sie die Befehlsfolge
Ansicht > Modelleinstellung > Farbe & Farbeffekte (View > Model Settings > Color &

Appearances).
2. Klicken Sie auf Hinzufuegen (Add). Der Farbeffekte-Editor (Appearance Editor) wird geöffnet.
3. Klicken Sie auf das Farbmuster-Feld im Abschnitt Farbe (Color). Der Farbeditor wird geöffnet.
4. Definieren Sie eine Farbe mit Hilfe des Farbeditors.
5. Klicken Sie auf OK. Sie kehren zum Farbeffekte-Editor zurück.
6. Schließen Sie die Definition des Farbeffekts ab. Legen Sie hierzu die gewünschten Optionen im

Farbeffekte-Editor fest.
7. Geben Sie einen Namen für den Farbeffekt ein (optional).
8. Klicken Sie auf OK. Der Farbeffekt wird zur Farbeffekte-Palette hinzugefügt. Wenn Sie mit dem

Cursor auf den Farbeffekt in der Palette zeigen, werden der Name und die Definition der Farbe
angezeigt.

Um einen Standardsatz von Farbeffekten für die Pro/ENGINEER-Sitzungen zu erzeugen, speichern Sie die
Datei ÅçäçêKã~é, und legen Sie diese Datei unter éêç|Åçäçêã~é|é~íÜ in der Datei config.pro
fest. Die .map-Datei wird bei jedem Starten einer Sitzung geladen.

So ändern Sie Farbeffekte vom Modell
Wenn Sie ein Modell mit Farbeffekten laden, ohne daß die entsprechende Datei ÅçäçêKã~é zur
Verfügung steht, können Sie die Definition der Farbeffekte aus dem Modell abrufen und in der Farbeffekte-
Palette speichern.

1. Klicken Sie auf die Schaltfläche Farbeffekt (Appearance) , oder wählen Sie die Befehlsfolge
Ansicht > Modelleinstellung > Farbe & Farbeffekte (View > Model Settings > Color &

Appearances).
2. Klicken Sie auf Vom Modell aendern... (Modify from Model...).
3. Wählen Sie den gewünschten Farbeffekt im Modell, und klicken Sie auf Fertig Ausw (Done Sel).
4. Überprüfen Sie die Richtung des Materials, und klicken Sie auf In Ordnung (Okay).
5. Ändern Sie gegebenenfalls die Materialeigenschaften mit Hilfe des Farbeffekte-Editors.
6. Geben Sie einen Namen für den Farbeffekt ein (optional).
7. Klicken Sie auf OK. Der Farbeffekt wird zur Farbeffekte-Palette hinzugefügt. Wenn Sie mit dem

Cursor auf den Farbeffekt in der Palette zeigen, werden der Name und die Definition der Farbe
angezeigt.

Tip: Farbeffekte erzeugen
Einer der häufigsten Fehler bei der Definition von Farbeffekten liegt darin, daß der Effekt mit zuviel Glanz
angelegt wird. Sie können und sollen kräftige Farben für das Rendering verwenden; stellen Sie hierbei
allerdings sicher, daß die Farben nicht zu stark glänzen. In diesem Fall würde das Modell künstlich wirken,
wie aus einem Comic entnommen. Mit dem Farbeffekte-Editor können Sie den Farbeffekt abtönen.
Verringern Sie den Glanz und die Intensität des Glanzlichts im Register Einfach (Basic), und mattieren Sie
die Reflexion im Register Spezial (Advanced). Darüber hinaus können Sie Texturmuster einsetzen, um die
realistische Darstellung des Modells zu verbessern.
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Farbeffekte-Editor
Der Farbeffekte-Editor enthält drei Register:

� Einfach (Basic) — Farbeigenschaften des Farbeffekts definieren.

� Spezial (Advanced) — Spezielle Eigenschaften definieren, beispielsweise Reflexion oder Transparenz.

� Detail — Textur für den Farbeffekt zuweisen (beispielsweise Beulenmuster oder Decal).

Die Änderungen werden noch während der Bearbeitung anhand der Kugel in der Farbeffekte-Palette
dargestellt. Bestimme Optionen für Farbeffekte werden allerdings erst in gerenderten Bildern sichtbar.
Aktualisieren Sie gegebenenfalls die gerenderten Farbeffekt-Kugeln durch Klicken mit der mittleren
Maustaste.

So bearbeiten Sie die Farbeffekt-Optionen über
die Registerkarte "Einfach"
Mit dem Register Einfach (Basic) können Sie Farben definieren und bearbeiten.

Die folgenden Befehle stehen für Farben zur Verfügung:

� Streulicht (Diffuse) — Steuert die Reflexion von Punktlichtquellen, gerichteten Lichtquellen und
Spotlichtquellen.

� Raumlicht (Ambient) — Steuert die Menge an Raumlicht, die an der Fläche reflektiert wird.

Die folgenden Befehle stehen für Glanzlichter zur Verfügung:

� Glanz (Shininess) — Steuert den Glanz der Fläche. Je glänzender die Fläche, desto kleiner ist das
Glanzlicht.

� Intensitaet (Intensity) — Steuert die Helligkeit des Glanzlichts; steht im direkten Zusammenhang mit
dem Glanz. Flächen, die auf Hochglanz poliert wurden, erhalten kleine, helle Glanzlichter, rauhe
Kunststoff-Flächen dagegen große, schwache Glanzlichter.

Alternativ ändern Sie die Farben durch Eingabe einer Zahl in das Optionsfeld neben dem Schieberegler.
Klicken Sie abschließend auf OK. Die aktuelle Farbe wird in der Farbeffekte-Palette angezeigt.

So bearbeiten Sie die Farbeffekt-Optionen über
die Registerkarte "Spezial"
Mit dem Register Spezial (Advanced) legen Sie spezielle Eigenschaften für Farbpaletten fest:

� Reflexion (Reflection) — Bestimmt die Reflexion des Raumes auf dem Bauteil. Bei matten
Farbeffekten wird der Raum nicht so stark reflektiert wie bei glänzenden Farbeffekten. Stoff reflektiert
beispielsweise weniger stark als Metall.

� Transparenz (Transparency) — Steuert das Ausmaß, in dem der Blick durch eine Fläche möglich ist.

� Schwellenwert (Threshold) — Bestimmt die anzuzeigenden Bereiche im Modell. Mit Hilfe des
Schwellenwerts können Sie das Innere von Objekten während der schattierten Darstellung anzeigen
lassen. Weisen Sie den einzelnen Farbeffekten jeweils einen Schwellenwert zu, und legen Sie
anschließend den Schwellenwert für das System fest. Farbeffekte, deren Schwellenwert über dem
systemeigenen Schwellenwert liegen, werden aus der Anzeige ausgeschlossen. Beim Rendering werden
die Schwellenwerte nicht berücksichtigt.

Mit der Befehlsfolge Ansicht > Spezial > Sichtbarkeit (View > Advanced > Visibilities) bestimmen Sie
den Schwellenwert des Systems.
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So bearbeiten Sie die Farbeffekt-Optionen über
die Registerkarte "Detail"
Mit dem Register Detail können Sie die Farbeffekte anhand von Texturen definieren. Klicken Sie auf die
Schaltfläche Mapping... (Map...) für den festzulegenden Texturtyp:

� Textur (Texture) — Texturmuster mit drei oder vier Kanälen, mit dem ein Bild auf einer Fläche oder
einem Teil modelliert wird.

� Bump Map (Bump Map) — Texturtyp, mit der die Oberflächenrauhigkeit nachgebildet wird. Beim
Anwenden von Beulenmuster legen Sie außerdem die Beulenhöhe fest; hiermit wird die Höhe oder die
Eindrucktiefe für die Beulenmuster-Werte bestimmt.

� Decal — Ein KE, das auf einer Fläche oder einem Teil plaziert wird (beispielsweise ein Logo). Ein
Decal umfaßt Bereiche, in denen der vorliegende Farbeffekt durch das Decal überlagert wird, sowie
Bereiche, in denen das Decal transparent ist, so daß der Farbeffekt durchscheint. Beim Erzeugen von
Decals legen Sie unter anderem dessen Intensität fest.

Wählen Sie eine Texturdatei im Datei-Browser.

So können Sie Farben erzeugen und bearbeiten
Mit dem Farbeditor können Sie Farben erzeugen und bearbeiten.

� Wenn Sie eine Farbe mit Hilfe des Farbkreises definieren, klicken Sie zunächst auf einen Farbton im
Farbkreis, und verwenden Sie anschließend den Schieberegler für die Helligkeit.

� Beim Einsatz der Mischpalette klicken Sie auf eine Ecke der Palette, und wählen Sie die gewünschte
Farbe für das Mischen im Farbkreis. Mit dem schwarzen Balken zwischen zwei Ecken können Sie die
beiden Farben gleichzeitig ändern. Auf diese Weise erzeugen Sie eindimensionale lineare Farbskalen.

� Mit den Schiebereglern für RGB erzeugen Sie eine Farbe durch Mischen von Rot-, Grün- und Blau-
Anteilen.

� Mit den HSV-Schiebereglern erzeugen Sie eine Farbe durch Mischen von Farbton, Sättigung, und
Farbwert.

Klicken Sie abschließend auf OK.

So wenden Sie Farbeffekte auf das Modell an
Sie können einen Farbeffekt ohne Textur für Baugruppen, Komponenten, Teile, Sammelflächen oder
Flächen einstellen. Falls Sie als Teil des Farbeffekts Textur zugewiesen haben, können Sie den Farbeffekt
Teilen, Sammelflächen oder Flächen zuweisen. Für Baugruppen und Komponenten werden Texturen
ignoriert.

1. Führen Sie die vollständige Definition des Farbeffekts mit dem Farbeffekte-Editor durch, und klicken
Sie auf OK.

2. Wählen Sie den anzuwendenden Farbeffekt in der Farbeffekte-Palette.
3. Geben Sie unter Objekt-Farbeffekte einstellen (Set Object Appearance) an, ob der Farbeffekt auf

das gesamte Teil, auf bestimmte Sammelflächen, auf Bezugskurven oder auf alle Objekte angewandt
werden soll.

4. Klicken Sie auf Einstellen (Set).
5. Nach Auswahl des gewünschten Bereichs im Modell wird der Farbeffekt zugewiesen.
6. Mit der Befehlsfolge Ansicht > Schattieren (View > Shade) lassen Sie den Farbeffekt im Modell

anzeigen.
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So speichern Sie Materialdateien
Farbeffekte werden zusammen mit dem Modell gespeichert; beim Laden des Modells werden die
Farbeffekte allerdings nicht berücksichtigt. Sie können eine gespeicherte Farbeffekte-Datei laden, die
Modell-Farbpaletten mit dem Befehl Vom Modell aendern (Modify from Model) zur Palette hinzufügen
oder auch die Farbeffekte-Datei unter éêç|Åçäçêã~é|é~íÜ in der Datei ÅçåÑáÖKéêç als
Standarddatei für die Pro/ENGINEER-Sitzungen festlegen.

1. Klicken Sie auf die Schaltfläche Farbeffekt (Appearance) , oder wählen Sie die Befehlsfolge
Ansicht > Modelleinstellung > Farbe & Farbeffekte (View > Model Settings > Color &

Appearances).
2. Erzeugen Sie die gewünschten Farbeffekte.
3. Wählen Sie die Befehlsfolge Datei > Speichern (File > Save).
4. Benennen Sie die Farbeffekt-Datei im Datei-Browser. Wenn Sie eine Datei ÅçäçêKã~é im

Installationsverzeichnis von Pro/ENGINEER speichern, wird diese Datei bei jedem Starten einer
Sitzung geladen.

So entfernen Sie Farbeffekte aus dem Modell
Um Farben aus dem Modell zu entfernen, wählen Sie den gewünschten Farbeffekt in der Farbeffekte-
Palette, und klicken Sie auf Einstell rueck (Unset).

Mit Entfernen (Remove) können Sie einen Farbeffekt aus der Farbeffekte-Palette löschen.

Allgemeine Einführung: Lichtquellen
Alle Renderings müssen mit einer Lichtquelle versehen werden. Erhöhen Sie die Qualität der Bilder anhand
von Glanzlichtern auf Teilen des Modells, oder erzeugen Sie eine Hintergrundbeleuchtung. Sie können
maximal 12 Lichtquellen für schattierte Renderings angeben; bei PhotoRender sind maximal 32
Lichtquellen möglich. Der Zeitaufwand für das Rendern steigt mit jeder Lichtquelle. Die folgenden
Lichtquellenarten stehen zur Verfügung:

� Raumlicht (Ambient) — Raumlichtquellen beleuchten alle Flächen gleichermaßen. Die Position der
Lichtquelle im Raum wirkt sich nicht auf das Rendering aus, unabhängig vom Winkel zwischen dem
Modell und der Lichtquelle. Die Raumlichtquelle kann sich beispielsweise oberhalb oder hinter der
Fläche befinden oder auch in großer Entfernung zur Fläche. Die resultierende Beleuchtung ist in allen
Fällen gleich.

� Punkt (Point) — Punktlichtquellen ähneln einer Glühlampe: Das Licht geht vom Mittelpunkt der
Lichtquelle aus. Die Lichtreflexion an Flächen ist unterschiedlich, abhängig von der Position der Fläche
relativ zur Lichtquelle.

� Richtung (Direction) — Gerichtete Lichtquellen geben parallele Lichtstrahlen ab. Alle Flächen
werden mit demselben Winkel beleuchtet, unabhängig von der Position. Mit dieser Lichtquellenform
wird die Sonne oder eine andere Lichtquelle in großer Entfernung simuliert.
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� Spot — Bei Spotlichtquellen bilden die Lichtstrahlen einen Kegel.

So verwenden Sie das Dialogfenster Lichtquellen
(Lights)
Mit dem Dialogfenster Lichtquellen (Lights) können Sie Lichtquellen erzeugen und löschen sowie
Lichtquellen-Dateien öffnen und schließen.

1. Klicken Sie auf die Schaltfläche Lichtquelle (Light) , oder wählen Sie die Befehlsfolge Ansicht

> Modelleinstellung > Lichtquellen (View > Model Setup > Lights).
2. Die Menüleiste Lichtquellen (Lights) enthält die folgenden Menüs und Befehle:

� Datei (File) — Umfaßt die folgenden Funktionen:

Oeffnen (Open) — Lichtquellen-Datei öffnen.
Speichern (Save) — Lichtquellen-Datei speichern.

� Lichtquelle (Light) — Umfaßt die folgenden Funktionen:

Darstellung umschalten (Toggle Display) — Die Lichtquelle wird während der Schattierung
oder des Renderns nicht angezeigt.
Neu (New) — Neue Lichtquelle erzeugen. Nach der Erzeugung können Sie die Werte und
Parameter für die Lichtquelle ändern, beispielsweise die Farbe, die Richtung oder die Position.
Loeschen (Delete) — Ausgewählte Lichtquellen löschen. Die Standard-Lichtquellen für
Raumlicht und gerichtetes Licht können nicht gelöscht werden.
Editieren (Edit) — Ausgewählte Lichtquelle mit dem Lichteditor bearbeiten.

3. Um den Lichteditor zu öffnen, klicken Sie auf eine der Lichtquellen-Schaltflächen an der Seite des
Dialogfensters Lichtquellen (Lights), oder wählen Sie die Befehlsfolge Lichtquelle > Neu (Light >

New).
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So erzeugen Sie Lichtquellen

1. Klicken Sie auf die Schaltfläche Lichtquelle (Light) , oder wählen Sie die Befehlsfolge Ansicht

> Modelleinstellung > Lichtquellen (View > Model Setup > Lights).
2. Fügen Sie eine Lichtquelle zur Liste hinzu. Klicken Sie hierzu auf eine der Lichtquellen-Schaltflächen,

oder wählen Sie die Befehlsfolge Lichtquelle > Neu (Light > New):

� Mit der Schaltfläche Richtung (Direction)  erzeugen Sie eine neue gerichtete Lichtquelle.

� Mit der Schaltfläche Punkt (Point)  erzeugen Sie eine neue Punktlichtquelle.

� Mit der Schaltfläche Spot  erzeugen Sie eine neue Spotlichtquelle.

3. Zur Bearbeitung einer vorhandenen Lichtquelle klicken Sie auf die Schaltfläche Editieren (Edit)

, oder doppelklicken Sie auf den Namen der Lichtquelle.

4. Um eine Lichtquelle auszuschalten, klicken Sie auf die Schaltfläche Umschalten (Toggle) ,
oder wählen Sie die Befehlsfolge Lichtquelle > Darstellung umschalten (Light > Toggle Display).
Auf diese Weise wird die Lichtquelle während der Schattierung oder des Renderns nicht angezeigt.

Definition der Lichtquellen
Die Beleuchtung ist ein wichtiger Aspekt für die Qualität des Renderings. Mit der Beleuchtung erzielen Sie
bestimmte Effekte in den Bildern, ebenso wie Fotografen, die Personen "in das richtige Licht setzen".
Wenn Sie über Fotografien von ähnlichen Konstruktionen verfügen, versuchen Sie, die Beleuchtung
anhand der Aufnahmen nachzubilden. Experimentieren Sie mit der Beleuchtung, und beachten Sie dabei
die folgenden Punkte:
� Eine gute Ausgangsposition für die Beleuchtung befindet sich wenig über und neben dem Blickpunkt

(beispielsweise ein Winkel von 45�). Hiermit simulieren Sie eine Lichtquelle, die sich über Ihrer
Schulter befindet.

� Verteilen Sie die Lichtquellen an verschiedenen Positionen, und achten Sie darauf, daß keine der
Lichtquellen zu stark dominiert.

� Bei Lichtquellen von nur einer Seite werden die Schatten im Modell zu scharf.

� Bei zu vielen Lichtquellen wirkt das Modell "verwaschen".

Reines, weißes Licht wird nur mit künstlichen Lichtquellen erzielt (beispielsweise in Laboren). In der
Regel sollten Sie dennoch nur einen geringen Farbanteil für die Lichtquellen verwenden. Farbige
Lichtquellen wirken sich positiv auf die Wirkung der gerenderten Bilder aus, können jedoch die
angewandten Farbeffekte verfälschen. Weitere Tips für die Definition von Lichtquellen:
� Bei "Außenaufnahmen" simulieren Sie den Erdboden mit warmen Farben, die von unten her reflektiert

werden, den Himmel dagegen mit kühlen, von oben her reflektierten Farben.

� Bei "Studioaufnahmen" verwenden Sie nahezu rein weiße Lichtquellen.

� Zur Simulation von Sonnenlicht verwenden Sie eine gerichtete Lichtquelle mit den FSH-Werten 10, 15,
100.

� Zur Simulation von Mondlicht setzen Sie eine gerichtete Lichtquelle mit den FSH-Werten 200, 39, 57
ein.

� Zur Simulation von Innenleuchten verwenden Sie eine gerichtete Lichtquelle mit den FSH-Werten 57,
21, 100.

Bei einigen Tips werden FSH-Werte für die Beleuchtung angegeben. Diese Werte sind in der Mehrzahl der
Fälle ausreichend. Beachten Sie allerdings, daß die jeweilige Darstellung von der Kalibrierung des
Monitors abhängig ist. Falls Sie die Einstellungen des Monitors an Ihre Anforderungen angepaßt haben,
können Sie diese Werte unter Umständen nicht einsetzen.
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So ändern Sie Lichtquellen
Nach der Erzeugung können Sie die Werte und Parameter für die Lichtquelle im Menü Lichtquelle

(Lights) ändern, beispielsweise die Farbe, die Richtung oder die Position.

1. Klicken Sie auf die Schaltfläche Lichtquelle (Light) , oder wählen Sie die Befehlsfolge Ansicht

> Modelleinstellung > Lichtquellen (View > Model Setup > Lights).

2. Wählen Sie eine Lichtquelle, und klicken Sie auf die Schaltfläche Editieren (Edit) , oder
doppelklicken Sie auf den Namen der Lichtquelle. Der Lichteditor wird geöffnet.

3. Doppelklicken Sie auf den Namen der Lichtquelle, und geben Sie den gewünschten Namen ein.
4. Klicken Sie auf den Abschnitt Intensität (Intensity) und dann auf die Schaltfläche Farbe (Color).

Ändern Sie die Farbe des Lichts mit dem Farbeditor.
5. Ändern Sie die folgenden Einstellungen mit dem Lichteditor:

� Schatten werfen (Cast Shadows) — Klicken Sie auf den Abschnitt Schatten (Shadow). Der
Abschnitt wird geöffnet. Klicken Sie auf Schatten werfen (Cast Shadows), so daß die Lichtquelle
beim Rendern einen Schatten wirft. Mit dieser Option gestalten Sie das Rendering realistischer, der
Zeitaufwand für die Berechnung wird allerdings erhöht. Mit dem Befehl Schatten auf Boden

(Shadows On Floor) auf der Registerkarte Options (Options) des Dialogfensters Render

Options (Render Options) lassen Sie die Schatten im Rendering darstellen.

Beim Rendern legen Sie mit der Option Schatten werfen (Cast Shadows) fest, ob die Lichtquelle
einen Schatten auf den Boden werfen kann.

� Spotwinkel (Spot Angle) — Nur bei Spotlichtquellen. Diese Option bestimmt die Größe des
Lichtkegels für die Spotlichtquelle. Die Eingabe der Werte erfolgt in Grad.

� Position — Ändert die Position der Lichtquelle.

� Richtung (Direction) — Ändert die Richtung der Lichtquelle.

6. Mit OK schließen Sie die Änderungen ab.

So löschen Sie Lichtquellen
Sie können alle Lichtquellen in der Liste löschen, mit Ausnahme der Standard-Lichtquellen.

1. Wählen Sie die zu löschende Lichtquelle in der Liste.

2. Klicken Sie auf die Schaltfläche Loeschen (Delete) , oder wählen Sie die Befehlsfolge
Lichtquelle > Loeschen (Light > Delete).

So öffnen Sie Lichtquellen-Dateien
1. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open) im Lichteditor. Das Dialogfenster

Oeffnen (Open) wird geöffnet.
2. Wechseln Sie mit dem Datei-Browser zur gewünschten Lichtquellen-Datei, und öffnen Sie die Datei.

So speichern Sie Lichtquellen-Dateien
1. Wählen Sie die Befehlsfolge Datei > Speichern Als (File > Save As) im Dialogfenster Lichtquellen

(Lights). Das Dialogfenster Speichern Als (Save As) wird geöffnet.
2. Geben Sie den Namen der Lichtquellen-Datei ein, und klicken Sie auf OK.

Raum
Der Raum ist der Schauplatz für ein Rendering. Er ist ein integraler Bestandteil eines gerenderten Bildes. In
einem ansprechend definierten Raum werden die positiven Eigenschaften der Modelle herausgestellt. Die
Raumdefinition umfaßt die Größe, die Position und die Wandmuster (zugewiesene Texturen).
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Der Raum kann quaderförmig oder zylindrisch angelegt werden. Sie können die Größe des Raums ändern
und wahlweise das Raster oder die Wandtexturen anzeigen lassen. Sind Räume oder Wandflächen als
Hintergrund vorhanden, werden diese automatisch schattiert dargestellt. In der nachstehenden Abbildung
wird ein Beispiel für einen Raum dargestellt.

So erzeugen Sie Räume
1. Klicken Sie auf die Schaltfläche Raum (Room) .
2. Mit der Befehlsfolge Raum > Zylindrisch (Room > Cylindrical) ändern Sie den Raum von einem

Quader in einen Zylinder. Zylindrische Räume umfassen einen Boden, eine Decke und eine Wand.
4. Mit den Optionen im Register Groesse (Size) ändern Sie die Größe des Raums. Legen Sie die Höhe

und die Breite der Decke, des Bodens und der Wände fest. Diese Werte werden dynamisch aktualisiert.
5. Um den Raum zu drehen, wechseln Sie zum Register Rotieren (Rotate), und stellen Sie die

gewünschten Werte mit den Schiebereglern Schwenkung (Tilt) und Y ein. Mit Raum-Rotation

zuruecksetzen (Reset Room Rotation) setzen Sie die Schwenkung des Raums und der y-Achse auf
den Wert 0 zurück.

6. Mit Raum an Modell-Rotation binden (Lock Room To Model Rotation) verknüpfen Sie die
Drehung des Modells mit dem Raum.

7. Zur Definition eines Raumrasters verwenden Sie die Registerkarte Darstellung (Display) im
Raumeditor.

8. Darüber hinaus können Sie Texturen für die Wände des Raums zuweisen. Weitere Informationen
finden Sie unter Siehe auch.

Tip: Darstellung mit schattierten Wänden
Mit der Befehlsfolge Ansicht > Modelldarstellung > Schattieren > Transparenz (View > Model

Display > Shade > Transparency) lassen Sie die schattierten Wände mit unterschiedlichen
Transparenzwerten darstellen.

Tip: Raum erzeugen
Die Qualität von Bildern ergibt sich unter anderem aus der Größe und der Ausrichtung des Raums sowie
aus der Plazierung von Texturen auf den Wänden, der Decke und dem Boden. Bei quaderförmigen Räumen
ist die Aufgabe, die Ecken des Raums realistisch wirken zu lassen, wahrscheinlich der komplizierteste
Schritt in der Raumerzeugung.
Um dieses Problem mit den Raumecken zu umgehen, können Sie einen zylindrischen Raum erzeugen oder
aber den Raum so groß anlegen, daß die Ecken nicht mehr in den Bildbereich fallen. Beim Rendern
verschieben Sie die Raumwände vom Modell weg, und vergrößern Sie die Modelldarstellung.
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So legen Sie ein Raumraster fest
1. Klicken Sie auf die Schaltfläche Raum (Room) .
2. Wechseln Sie zum Register Darstellung (Display). Die Raster werden im Feld Drahtmodellattribute

(Wireframe Attributes) aufgeführt.
3. Wählen Sie die Raster, die im Raum dargestellt werden sollen.
4. Legen Sie die Rasterdichte im Feld Rasterlinien (Grid Lines) fest.
5. Klicken Sie auf OK. Die Änderungen werden übernommen.

So wenden Sie Texturen auf Räume an
 Sie können den Wänden eines Raums Texturen zuweisen. Weisen Sie die Textur nur einer Wand oder
allen sechs Wänden gleichzeitig zu.

1. Klicken Sie auf die Schaltfläche Raum (Room) .
2. Öffnen Sie das Dialogfenster Datei waehlen (Select File). Wählen Sie hierzu die gewünschte Option

aus der Dropdown-Liste, klicken Sie auf eine Raum-Schaltfläche, oder klicken Sie auf Textur laden

(Load Texture).
3. Wählen Sie eine Wandmusterdatei. (Die Dateierweiterung für Wandmusterdateien ist KíñN oder

KíñP.) Pro/ENGINEER stellt das Muster an der Wand dar.
4. Plazieren Sie die Textur im Raum. Verwenden Sie hierzu die Optionen im Dialogfenster Material-

Plazierung (Material Placement).
5. Wiederholen Sie Schritt 1 bis 4 für die einzelnen Wände, denen eine Textur zugewiesen werden soll.
6. Klicken Sie auf OK. Die Änderungen werden übernommen und gespeichert.

So öffnen Sie Räume
1. Wählen Sie die Befehlsfolge Datei > Oeffnen (File > Open) im Raumeditor. Das Dialogfenster

Oeffnen (Open) wird geöffnet.
2. Wechseln Sie mit dem Datei-Browser zur gewünschten Raum-Datei, und öffnen Sie die Datei.

So speichern Sie Räume
1. Wählen Sie die Befehlsfolge Datei > Speichern Als (File > Save As) im Raumeditor. Das

Dialogfenster Speichern Als (Save As) wird geöffnet.
2. Geben Sie den Namen der Raum-Datei ein, und klicken Sie auf OK.

So ändern Sie perspektivische Ansichten
Bei der perspektivischen Ansicht wird eine Perspektive eines schattierten Modells oder Drahtmodells von
einem bestimmten Fluchtpunkt aus erzeugt. Sie können das Objekt verfolgen, während die Ansicht
aktualisiert wird (entlang einer Kurve, einer Achse, einem Kabel oder einer Kante am Objekt). Wählen Sie
einen Ansichtsweg; anschließend können Sie die Position des Modells steuern, die perspektivische Ansicht
drehen, vergrößern und verkleinern sowie den Blickwinkel ändern.

1. Wählen Sie die Befehlsfolge Ansicht > Spezial > Perspektive (View > Advanced > Perspective).
2. Bestimmen Sie ein Verfahren zur Verschiebung der Ansicht:

� Virtuell durchfliegen (Fly Through) � Manuelles Verfahren zur Änderung der perspektivischen
Ansicht:

Linke Maustaste � Bewegung auf das Objekt zu. Wenn Sie die linke Maustaste mehrmals
drücken oder gedrückt halten, erhöht sich die zum Objekt hin gerichtete Geschwindigkeit.
Während einer Bewegung, die vom Objekt weg gerichtet ist, bewirkt das Drücken der linken
Maustaste jedoch, daß die vom Objekt weg gerichtete Bewegung sich verlangsamt.
Rechte Maustaste � Bewegung vom Objekt weg.  Wenn Sie die rechte Maustaste mehrmals
drücken oder gedrückt halten, erhöht sich die vom Objekt weg gerichtete Geschwindigkeit.
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Während einer Bewegung zum Objekt hin bewirkt das Drücken der linken Maustaste, daß die
Bewegung verlangsamt wird.
Mittlere Maustaste � Bewegung anhalten. Wenn die Bewegung gestoppt ist, können Sie durch
Drücken der mittleren Maustaste den Blickpunkt im Verhältnis zum Objekt drehen.

� Virtuell begehen (Walk Through) � Entspricht der Option Virtuell durchfliegen (Fly

Through) bei geringerer Geschwindigkeit.

� Von Bis (From/To) � Der Ansichtsweg wird durch zwei Bezugspunkte oder Endpunkte definiert.

� Weg folgen (Follow Path) � Der Ansichtsweg wird durch eine Achse, eine Kante, eine Kurve
oder eine Silhouette definiert.

3. Die folgenden Optionen stehen zur Verfügung:
� Dynamisch aktualisieren (Dynamic Update) � Ansicht bei Änderungen an den Einstellungen

automatisch aktualisieren.

� Augabstand (Eye Dist) � Blickpunkt entlang des gewählten Wegs am Modell entlang bewegen.
Bei schattierten Modellen ist kein Unterschied erkennbar, wenn der Weg innerhalb des Modells
liegt.

� Augpunkt rotieren (Rotate Eye) � Drehung um Achsen festlegen. Zulässige Werte: -180 bis
+180 Grad.

� Augpunkt verschieben (Pan Eye) � Position der Darstellung bestimmen.

� Zoomen (Zoom) � Vergrößerung oder Verkleinerung der Darstellung (in Prozent).

� Blickwinkel (View Angle) � Blickwinkel festlegen; zulässige Werte: 0 bis 45 Grad.

4. Mit OK übernehmen Sie die Werte, mit Widerrufen (Undo) werden die aktuellen Einstellungen
verworfen.

Benutzeroberfläche für das Rendern
Zum Einsatz von PhotoRender wählen Sie ein aktuelles Arbeitsmodell, und verwenden Sie die
Befehlsfolge Ansicht > Spezial > PhotoRender (View > Advanced > PhotoRender). Die Menüleiste von
PhotoRender enthält die folgenden Funktionen:

 Bild oeffnen (Open Image) � Bilddatei öffnen und auf dem Bildschirm anzeigen.

 Bild speichern (Save Image) � Aktuelles Bild in Datei speichern.

 Konfiguration (Configuration) � Einstellungen und Voreinstellungen für das Rendern
anpassen.

 Raum (Room) � Rendering-Raum definieren.

 Lichtquellen (Lights) � Satz von Lichtquellen für das Rendern definieren.

 Farbeffekte (Appearances) � Farbeffekte definieren und auf das Modell anwenden.

 Perspektive (Perspective) � Perspektivische Ansicht bearbeiten.

 Orientierung (Orientation) � Orientierung des Modells ändern.

 Bildeditor (Image Editor) � Bilddateien anzeigen lassen und bearbeiten.

 Render � Objekt rendern.

 Stillegen (Shutdown) � Alle Prozesse anhalten.

 Close (Schliessen) � Menüleiste von PhotoRender schließen.
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So rendern Sie Modelle
Bei PhotoRender werden alle Elemente einer Szene zusammengestellt (Modell, Materialien, Raum,
Lichtquellen) und anschließend ein Bild erzeugt. Aus gerenderten Bildern geht hervor, wie die Umgebung
auf einer Fläche reflektiert wird. Auf diese Weise können Sie Fehler in der Konstruktion ermitteln oder
auch das Erreichen der Konstruktionsziele feststellen. Darüber hinaus ist ersichtlich, wie das modellierte
Objekt unter realen Bedingungen wirkt (bei realistischer Beleuchtung, Schattierung und Umgebung).

1. Laden Sie das Teil oder die Baugruppe.
2. Definieren Sie Farbeffekte für das Teil oder die Flächen, und wenden Sie diese an.
3. Definieren Sie einen Rendering-Raum. Bestimmen Sie die Größe und die Ausrichtung des Raums

gemäß des Modells und dem Render-Verfahren. Wenden Sie gegebenenfalls Texturen auf den Raum
an, um so einen Hintergrund für das Bild zu erzeugen.

4. Erzeugen und positionieren Sie Lichtquellen. Beleuchten Sie das Modell aus unterschiedlichen
Winkeln mit verschiedenen Lichtquellen.

5. Verschieben und drehen Sie das Modell, bis die gewünschte Ansicht erzielt wird. Ändern Sie
gegebenenfalls die Perspektive der Ansicht.

6. Wählen Sie die gewünschten Rendering-Optionen im Dialogfenster Rendering-Konfiguration

(Rendering Configuration).

7. Klicken Sie auf die Schaltfläche Render .
8. Speichern Sie das Bild bei Bedarf in einer Datei. Oder ändern Sie die Rendering-Einstellungen und

rendern Sie erneut.

Schattierte Modelle
Sie können schattierte Bilder erzeugen, die in Echtzeit bewegt werden. Für schattierte Bilder gelten gewisse
Einschränkungen. Es liegen stets matte Farbeffekte vor, weil die Umgebung nicht auf der Fläche reflektiert
wird. Texturen werden zwar auf Hardware-Plattformen mit schattierten Grafiken unterstützt; die Leistung
sinkt allerdings, wenn die Grafikkarte keine Unterstützung für Hardware-Texturen bietet.

Die Anzahl der für schattierte Bilder verfügbaren Lichtquellen wird durch Ihre Plattform bestimmt. Auf
Sun Solaris Plattformen ist die maximale Anzahl 12. Auf SGI, IBM, HP oder anderen Sun Plattformen ist
die maximale Anzahl 8.

Mit der Befehlsfolge Ansicht > Schattieren (View > Shade) erzeugen Sie schattierte Bilder. Das aktuelle
Arbeitsmodell wird mit den Standardfarben oder mit benutzerdefinierten Farben schattiert dargestellt.

Bilder speichern
Sie können Bilder während des Renderns oder auch während der Ansicht in eine Datei speichern. Mit dem
Bildeditor können Sie unterstützte Bilddateien bearbeiten.

� Registerkarte Setup (Setup) im Dialogfenster Render-Konfiguration (Render Configuration) �
Verwenden Sie die diese Registerkarte, wenn das Bild in jedem Fall nach dem Rendern gespeichert
werden soll. Lassen Sie eine Vorschau des Bildes anzeigen, und nehmen Sie Änderungen vor, bis das
gewünschte Ergebnis erzielt wird. Erhöhen Sie gegebenenfalls die Auflösung, und legen Sie unter
Render-Ausgabe in (Render To) einen Bildtyp fest, der beim Speichern des Bildes während des
Renderns eingesetzt werden soll.

� Falls Sie zunächst das gerenderte Bild anzeigen lassen und dann erst entscheiden möchten, ob die
Speicherung erfolgen soll, führen Sie zunächst den Render-Vorgang aus, und speichern Sie das Bild mit

der Schaltfläche Bild speichern (Save Image) .

� Zum Speichern von schattierten Bildern verwenden Sie die Befehlsfolge Datei > Exportieren > Bild

(File > Export > Image).

Mit dem Bildeditor können Sie einzelne Bilder anzeigen lassen oder auch mehrere Bilder nacheinander (in
einer "Diaschau").
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So bearbeiten Sie Bilder

1. Klicken Sie auf die Schaltfläche Bildeditor (Image Editor) .
2. Ändern Sie das Bild anhand der Schaltflächen im Bildeditor.

Bild um 10% vergrößern

Bild um 10% verkleinern.

Bild um 100% vergrößern

Bild um 100% verkleinern

Bild um 90 Grad im Uhrzeigersinn drehen

Bild um 90 Grad im Gegenuhrzeigersinn drehen

Bild um vertikale Achse spiegeln

Bild um horizontale Achse spiegeln

Bild auf gewählten Ausschnitt zuschneiden

3. Setzen Sie die Bearbeitung des Bildes mit Hilfe der Menüoptionen im Bildeditor fort.
4. Wählen Sie die Befehlsfolge Datei > Speichern (File > Save). Das Bild wird gespeichert.

Bildoptionen
Der Bildeditor enthält die folgenden Menüs und Befehle:

� Editieren (Edit ) — Umfaßt die folgenden Optionen:

� Widerrufen (Undo)

� Cut (Cut) — Der gewählte Bereich wird aus dem Bild entfernt.

� Kopieren (Copy) — Der gewählte Bereich wird kopiert.

� Einfuegen (Paste) — Der geschnittene oder kopierte Bereich wird in das Bild eingefügt.

� Ansicht (View) — Umfaßt die folgenden Optionen:

� Alphakanal darstellen (Display Alpha Channel) — Der Alphakanal wird angezeigt.

� Cursor-Position (Cursor Position) — Die x- und y-Koordinaten des Cursors werden in der
unteren rechten Ecke des Bildeditors aufgeführt.

� ARGB-Wert des Pixels (Pixel ARGB Value) — Die Alpha- und RGB-Werte an der Pixelposition
des Cursors werden in der unteren rechten Ecke des Bildeditors aufgeführt.

� Bild (Image) — Umfaßt die folgenden Optionen:

� Groesse... (Size...) — Größe des Bildes ändern.

� Spiegel (Mirror) — Spiegeln in horizontaler oder vertikaler Richtung.

� Rotieren (Rotate) — Drehung im Uhrzeigersinn oder gegen den Uhrzeigersinn.

� Zuschneiden (Crop) — Bild zuschneiden.
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� Wiederholen (Repeat) — Bild duplizieren. Mit dieser Option erzeugen Sie gekachelte Texturen,
die größer sind als die ursprüngliche Bilddatei.

� Unscharf machen... (Blur...) — Bildschärfe reduzieren. Zulässige Werte: 2 bis 9.

� Mit Oelfarbe malen (Oil Paint) — Ölfarben-Effekt für das Bild erzeugen.

� Verwischen... (Smear...) — Bild verwischen.

� Schaerfen... (Sharpen...) — Bildschärfe erhöhen. Zulässige Werte: 0,0 bis 1,0.

� Aufhellen... (Brighten...) — Helligkeit des Bildes erhöhen.

� Saettigung... (Saturation...) — Sättigung des Bildes ändern.

� Abtoenen... (Tint...) — Farbton des Bildes ändern.

� Grauskala (Grey Scale) — Bild in Graustufen konvertieren.

� Praegen (Emboss) — Präge-Effekt für das Bild erzeugen.

� Alphakanal erzeugen... (Create Alpha Channel...) — Weiße Pixel im aktuellen Bild erfassen
und in transparente Kanäle umwandeln.

� Dia-Show... (Slide Show...) — Mehrere Bilder in einer "Diaschau" anzeigen lassen.

So verwenden Sie das Dialogfenster Dia-Show
(Slide Show)
1. Wählen Sie die Befehlsfolge Bild > Dia-Show... (Image > Slide Show...). Das Dialogfenster Dia-

Show (Slide Show) wird geöffnet.
2. Mit Einfuegen (Insert) können Sie einzelne Dateien zur Diaschau hinzufügen. Mit Verz anhaengen

(Append Dir) lassen Sie alle Bilder eines Verzeichnisses in die Diaschau aufnehmen.
3. Wechseln Sie mit dem Datei-Browser zum Verzeichnis der Bilddateien, und wählen Sie gegebenenfalls

die gewünschten Dateien. Um mehrere Bilder auszuwählen, halten Sie die STRG-Taste gedrückt,
während Sie auf die Dateien klicken.

4. Klicken Sie im Datei-Browser auf OK.
5. Mit den folgenden Verfahren steuern Sie die Diaschau:

� Verwenden Sie die Schaltflächen im Dialogfenster Dia-Show (Slide Show).

 Die Bilder werden in einer fortlaufenden Schleife angezeigt.

 Die Bilder werden einmalig angezeigt; nach Durchlauf aller Bilder wird der Vorgang
beendet.

 Die Größe der Bilder wird an die Fenstergröße angepaßt. Das Verhältnis von Breite und
Höhe wird beibehalten.

 Die Bilddateien werden gespeichert. Die Wiedergabe der Bilder wird beschleunigt, weil
die Dateien nicht immer wieder von der Festplatte geladen werden müssen.

� Positionieren Sie den Cursor in das Bilddarstellungsfenster, und verwenden Sie die Pfeiltasten.

Wiedergabe

Anhalten

Naechst.Vorig.
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� Verwenden Sie Tasten auf der Tastatur.

LEERTASTE: Wechsel zwischen Wiedergabe und Anhalten
P: Wiedergabe
S: Anhalten

So ändern Sie die Orientierung
Mit dem Dialogfenster Orientierung (Orientation) ändern Sie die Ansicht des Modells. Die Ansicht
ergibt sich aus einer Achse oder zwei Flächen über zwei Ebenen; das Modell wird an der Referenz
orientiert.

1. Klicken Sie auf die Schaltfläche Orientierung (Orientation) .
2. Legen Sie für Referenz 1 (Reference 1) fest, ob eine Ebene oder eine Achse als Referenz für die

Orientierung dienen soll.
3. Klicken Sie auf Horizontale Achse (Horizontal axis) oder Vertikale Achse (Vertical axis). Wählen

Sie die gewünschte Achse auf dem Bildschirm oder im Dialogfenster. Das Modell wird in der Ansicht
orientiert.

4. Wenn Sie eine Ebene als Referenz einsetzen, verwenden Sie eine der anderen Optionen im Menü, und
wählen Sie die gewünschte Fläche in der Ansicht. Die ausgewählte Fläche wird an der definierten
Ebene ausgerichtet. Zum Abschluß der Orientierung muß allerdings ein weiterer Referenzpunkt
angegeben werden.

5. Zur Ausrichtung einer Fläche an einer Ebene legen Sie die gewünschte Ebene unter Referenz 2

(Reference 2) fest.
6. Wählen Sie die Fläche, die an der zweiten Referenzebene orientiert werden soll. Das Modell wird in der

Ansicht orientiert.
7. Speichern Sie gegebenenfalls die Ansicht. Geben Sie den Namen der Ansicht unter Gespeicherte

Ansichten (Saved Views) ein.
8. Klicken Sie auf OK.

Terminologie für Rendering
Alpha

Optionaler vierter Kanal in RGB-Bilddateien, in der Regel für das Zusammensetzen.

Raumlichtquelle

Lichtquelle, die sich auf alle Teilstücke aller Objekte in der Rendering-Szene
gleichermaßen auswirkt.

Raumlichtreflektion

Flächeneigenschaft; Lichtmenge von einer Raumlichtquelle, die von der Fläche reflektiert
wird, unabhängig von der Position oder des Winkels der Lichtquelle.

Farbeffekt

Satz von Attributen, die die Farbeffekte einer Fläche bestimmen. Beispiele: Farbe,
Reflexionsvermögen, Transparenz, Textur.

Farbeffekte-Kugel

Kugel im Farbeffekte-Editor, mit der die aktuellen Eigenschaften der Farbeffekte
dargestellt werden.

Rückseite

Rückseite einer Fläche.
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Helligkeit

Eigenschaft von Farbeffekten, die die Intensität nach Auswahl des Farbtons bestimmt.

Beulenmuster

Einkanalige Textur, mit der die Oberflächenrauhigkeit nachgebildet wird.

Beulenhoehe

Höhe oder Eindrucktiefe der Beulenmuster-KEs.

Clipping

Rendering-Option, mit der lediglich das Teilstück des Modells gerendert wird, das
zwischen den beiden Clipping-Ebenen liegt.

Farbe

Flächenfarbe von beleuchteten Modellen.

Farbmischer

Bestandteil des Farbeditors; enthält einen fortlaufenden Farbbereich. Mischen Sie Farben
zwischen den vier Farbpaletten des Farbmischers.

Farbkasten

Bestandteil des Farbeditors. Definieren Sie Farben entlang zwei Achsen auf der
Grundlage von den Rot-, Grün- und Blau-Anteilen.

Farbpalette

Bestandteil des Farbeditors; enthält einen Farb-Array.

Farbtextur

Dreikanalige Textur mit Rot-, Grün- und Blau-Anteilen.

Farbkreis

Bestandteil des Farbeditors. Wählen Sie Farben anhand des Farbtons, der Sättigung und
der Helligkeit.

Decal

Vierkanaliges Texturmuster, bestehend aus einem Standard-Farbtexturmuster und einem
Kanal für Transparenz (Alpha-Kanal). Siehe Alpha.

Decal-Intensitaet

Intensität des Decalmusters.

Gerichtetes Licht

Lichtquelle, mit der parallele Lichtstrahlen erzeugt werden; simuliert die Sonne.

Gamma

Direkte nichtlineare Darstellung von Intensitätswerten durch ein Anzeigegerät
(Bildschirm).
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Gamma-Korrektur

Korrektur der Bilddaten: Lineare Änderungen an den Bilddaten führen zu linearen
Änderungen am dargestellten Bild.

Glanzlicht-Farbe

Farbe des Glanzlichts, das vom Modell reflektiert wird.

Glanzlicht-Qualität (Highlight Quality)

Rendering-Option, mit der die Qualität der gerenderten Glanzlichter gesteuert wird.

Glanzlicht-Konzentration (Highlight Shine)

Konzentration oder Streuung des Glanzlichts; je kleiner das Glanzlicht, desto glänzender
die Fläche.

Glanzlicht-Intensität (Highlight Intensity)

Helligkeit des Glanzlichts.

Farbton

Farbschattierung, durch die eine Farbe definiert wird.

Farbton, Sättigung, Helligkeit (Hue, Saturation, Brightness)

Kombination aus dominanter Wellenlänge, Reinheit und Intensität, mit der eine Farbe
vollständig definiert wird.

Grafik

Das Bild, das beim Rendern erzeugt wird. Bilder können auf dem Bildschirm ausgegeben
und/oder in eine Datei geschrieben werden.

Bibliothek

Sammlung von Texturen, Farbeffekten, Räumen und Lichtquellen, die gemeinsam auf
der Festplatte gespeichert werden; stehen beim Zuweisen von Teilen zu Szenen schnell
und einfach zur Verfügung.

Lichtquelle

Notwendig für alle Renderings. Lichtquellen werden durch Position, Farbe und Helligkeit
definiert. Bestimmte Lichtquellen umfassen außerdem Richtung, Streuung oder
Konzentration. Es gibt vier Arten von Lichtquellen: Raumlicht, Gerichtetes Licht,
Punktlicht und Spotlicht.

Raum beleuchten (Light Room)

Rendering-Option, mit der bestimmt wird, ob der Raum durch benutzerdefinierte
Lichtquellen oder durch eine Standard-Raumlichtquelle ausgeleuchtet werden soll.

Zuordnungsverfahren

Spezifikationen für die Zuordnung von Texturen zu Flächen. Sie können unter planarer,
zylindrischer und sphärischer Zuordnung wählen.
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Palette

Sammlung von Rendering-Objekten, die gemeinsam in einem Editor dargestellt werden.
Paletten stehen für Farbeffekte und für Lichtquellen zur Verfügung.

PhotoRender

Rendering-Dienstprogramm, mit dem photorealistische Bilder aus Szenen erzeugt
werden.

Pixel

Einzelner Punkt in einem Bild; wird als Kombination der drei Primärfarben dargestellt.
Rot, Grün und Blau.

Punktlichtquelle

Lichtquellenart, bei dem das Licht vom Mittelpunkt der Glühlampe ausgeht.

Vorschau

Bereich im Perspektivenfenster, in dem der Inhalt des Bilds vor dem Rendern dargestellt
wird.

Reflect Model in Floor (Reflect Model in Floor)

Rendering-Option, mit der ein Modell beim Rendern auf dem Boden reflektiert wird.

Raum reflektieren (Reflect Room)

Rendering-Option, mit der die Reflexion des Raums auf das Modell gesteuert wird.

Reflexion

Ausmaß, in dem ein Modell die Umgebung reflektiert.

Render

Schattiertes Bild erzeugen, um so dem Modell ein realistischeres Aussehen zu verleihen.

Renderqualitaet

Rendering-Option, mit der die Qualität beim Flächen-Rendering eines Modells gesteuert
wird.

Raum rendern

Rendering-Option, mit der die Darstellung des Raums während des Rendering
umgeschaltet wird.

RGB

Rot-, Grün- und Blau-Anteil einer Farbe.

Raum

Umgebung, in der das Modell gerendert wird. Quaderförmige Räume umfassen vier
Wände, eine Decke und einen Boden.  Zylindrische Räume bestehen aus einer Wand,
einem Boden und einer Decke. Sie können den Raum mit einem Raster darstellen lassen
oder auch Texturen auf den Raum anwenden.
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Saettigung (Saturation)

Reinheit des Farbtons in einer Farbe. Beispiel für eine "ungesättigte" Farbe: Grau.

Eigenschatten (SelfShadows)

Rendering-Option, mit der Schatten eines Modells auf das Modell selbst geworfen
werden.

Schatten auf Boden

Rendering-Option, mit der die Schatten auf dem Boden umgeschaltet werden.

Geometrische Textur schaerfen (Geometric Textures Sharpen)

Rendering-Option, mit der Sie geometrische Texturen mit größerer Klarheit rendern
lassen.

Texturen im Winkel schärfen (Sharpen Textures at Angle)

Rendering-Option, mit der das Bild von Texturen geschärft wird, die in einem flachen
Winkel zur Ansicht gerendert werden.

Dia-Show (Slide Show)

Dienstprogramm zur Darstellung mehrerer Bilder in einer Folge.

Spotlichtquelle

Lichtquellenart, bei der die Lichtstrahlen auf einen Kegel begrenzt werden.

Spotlicht-Schatten auf Boden (Spotlight Shadows on Floor)

Rendering-Option, mit der bestimmt wird, ob der Boden sich im Schatten außerhalb des
Spotlicht-Kegels befinden soll.

Spotwinkel

Durchmesser des Lichtkreises von Spotlichtern.

Spotlichtkonzentration

Schärfe des Lichtstrahls bei Spotlichtquellen.

Flaeche

Dreidimensionale Form, mit der ein geometrisches Objekt definiert wird.

Texturen

Bild, mit dem die Farbe oder die Farbeffekte einer Fläche bestimmt werden. Siehe
Farbeffekt.

Transparenz

Ausmaß, in dem der Blick durch eine Fläche möglich ist.

Benutzerbibliothek

Verzeichnis, das von mehreren Konstrukteuren oder für zahlreiche verschiedene Modelle
genutzt wird. Verzeichnis für gemeinsam genutzte Daten.
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Texturen
Texturen werden auf Flächen angewandt, die nicht allein mit Farben dargestellt werden können,
beispielsweise Holzmaserung oder textile Stoffe. Ein Texturmuster ist eine spezielle Bilddatei. Sie können
diese Dateien mit Programmen wie 3DPAINT erzeugen oder auch aus eingescannten Fotografien bilden.
Darüber hinaus können Sie die Texturen aus Pro/ENGINEER nutzen. Die folgenden Arten von Texturen
können auf Flächen oder Teile angewandt werden:

� Flächentexturen — Diese Texturdateien werden auf vollständige Flächen angewandt. Mit den
Texturmustern werden Flächenfarben dargestellt. In der Regel werden eingescannte Grafiken
verwendet, beispielsweise Holzmaserungen, geometrische Muster oder Bilder. Die Holz-Textur im
nachstehend abgebildeten Ventilatormodell ist ein Beispiel für eine Farbtextur.

� Decals — Decals sind spezielle Texturmuster, beispielsweise Unternehmens-Logos oder Text; diese
Muster werden auf Flächen angewandt. Ein Decal ist eine Textur mit einer Transparenzmaske
(Alphamaske). Decals bestehen aus einer Matrize und einer Decal-Textur. Falls die Texturdatei keinen
Alphakanal aufweist, wird ein Standard-Alphakanal erzeugt. Die Matrize wird auf die Fläche
angewandt. Anschließend wird die Textur an den Stellen auf die Fläche aufgetragen, die nicht von der
Matrize abgedeckt werden. Dies resultiert in einem Flächen-Decal. Dieser Vorgang entspricht dem
Auflegen einer Matrize auf eine Fläche und dem Auftragen einer Textur über die Matrize. Beim
Abnehmen der Matrize verbleibt das Decal auf der Fläche.

Das Armbanduhr-Modell enthält zwei Decals: das Ziffernblatt und die Wörter Parametric Technology.



Pro/PHOTORENDER 33

� Beulenmuster — Beulenmuster sind einkanalige Texturmuster für Höhenfelder. Beim Schattieren der
Fläche wirken sich die Höhenwerte auf die Senkrechtenvektoren aus. Die resultierende Fläche wirkt
faltig oder unregelmäßig. Die endgültige Beulenmuster-Textur wird lediglich in gerenderten Bildern
sichtbar.

Mit der Registerkarte Detail im Farbeffekte-Editor legen Sie die Beulenhöhe fest. Bei negativen
Werten werden die Beulen als Eindrücke in die Fläche plaziert.
Dieses Modell der Lauffläche eines Reifens ist ein Beispiel für den Einsatz von Beulenmustern zur
Simulierung der Oberflächenrauhigkeit:

Zur Anzeige der Texturen in der schattierten Darstellung wählen Sie die Befehlsfolge Ansicht >

Modelldarstellung > Schattieren > Texturen (View > Model Display > Shade > Textures).

Texturen speichern
Bei der Installation von Pro/ENGINEER umfaßt unter anderem eine Graphics-Bibliothek mit zahlreichen
Texturen. Diese Bibliothek wird durch den Systemadministrator installiert. Mit den Texturmuster-
Schaltflächen im Farbeffekte-Editor greifen Sie auf diese Bibliothek zu.
Sie können die vorhandene PTC-Graphics-Bibliothek verwenden oder auch eigene Texturdateien erzeugen.
Legen Sie ein Texturverzeichnis an, und speichern Sie dort alle Texturdateien. Bearbeiten Sie anschließend
die Datei ÅçåÑáÖKéêç; geben Sie enter texture_search_path den Pfad zum Texturverzeichnis an.
Auf diese Weise stehen die Texturdateien beim nächsten Öffnen des Teils oder der Baugruppe zur
Verfügung. Darüber hinaus wird dieses Verzeichnis durchsucht, wenn Sie den Namen einer Texturdatei im
Dialogfenster Datei oeffnen (File Open) angeben.

So erzeugen Sie Texturen anhand von
Farbeffekten
Verwenden Sie die Texturen aus der Graphics-Bibliothek, oder erzeugen und speichern Sie eine eigene
Textur-Bibliothek, und geben Sie den Suchpfad für die Texturen an. Farbeffekte mit Textur können Teilen,
Sammelflächen oder Flächen zugewiesen werden. Für Baugruppen und Komponenten werden Texturen
ignoriert.

1. Klicken Sie auf die Schaltfläche Farbeffekt (Appearance) , oder wählen Sie die Befehlsfolge
Ansicht > Modelleinstellung > Farbe & Farbeffekte (View > Model Settings > Color &

Appearances).
2. Klicken Sie auf Hinzufuegen (Add). Der Farbeffekte-Editor (Appearance Editor) wird geöffnet.
3. Erzeugen Sie eine Farbe für den Farbeffekt (optional). Bei der Definition von Farbeffekten mit

Beulenmustern und Decals werden Farben benötigt, weil die zugrunde liegende Farbe durch die Textur
sichtbar ist. Farbtexturen decken in der Regel eine Fläche oder ein Teil vollständig ab, so daß keine
zugrunde liegende Farbe notwendig ist.

4. Wechseln Sie zum Register Detail im Farbeffekte-Editor (Appearance Editor).
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5. Klicken Sie auf die Schaltfläche Mapping... (Map...) für den gewünschten Texturtyp. Wählen Sie die
Datei im Datei-Browser, oder geben Sie den vollständigen Namen der Texturdatei ein. Falls Sie ein
Verzeichnis unter texture_search_path in der Datei config.pro angegeben haben, wird die
Texturdatei in diesem Verzeichnis gesucht.

6. Ändern Sie den Beulenhöhen-Koeffizienten und den Decalintensität-Koeffizienten.
7. Geben Sie einen Namen für den Farbeffekt ein (optional).
8. Klicken Sie auf OK. Die Definition des Farbeffekts wird abgeschlossen. Wenn Sie mit dem Cursor auf

das Farbeffekt-Referenzmuster in der Palette zeigen, wird der Name dieses Musters angezeigt.

So plazieren Sie Texturen
Eine Textur kann ohne weiteres auf mehreren Flächen gleichzeitig plaziert werden. Sie sollten die Texturen
jedoch nacheinander auf die einzelnen Flächen anwenden, um so sicherstellen zu können, daß die Texturen
ordnungsgemäß ausgerichtet sind. Unter Umständen erzielen Sie die gewünschten Ergebnisse nur durch
Experimentieren, abhängig von der Textur.

1. Klicken Sie auf die Schaltfläche Farbeffekt (Appearance) , oder wählen Sie die Befehlsfolge
Ansicht > Modelleinstellung > Farbe & Farbeffekte (View > Model Settings > Color &

Appearances).
2. Wählen Sie den Farbeffekt aus der Palette.
3. Legen Sie mit den Befehlen im Menü Objekt-Farbeffekte einstellen (Set Object Appearance) an, ob

der Farbeffekt auf das gesamte Teil, auf bestimmte Flächen oder auf andere Objekte angewandt
werden soll.

4. Klicken Sie auf Einstellen (Set). Das Dialogfenster Material-Plazierung (Material Placement) wird
geöffnet.

5. Bestimmen Sie eine Projektion für die ausgewählte(n) Fläche(n):
� Planar — Für flache, nicht komplexe Objekte und Flächen. Die Textur wird auf den gesamten

ausgewählten Bereich angewandt.

� Sphaerisch (Spherical) — Für kugelförmige Objekte und Flächen. Die Textur wird relativ zu
einem benutzerdefinierten Koordinatensystem plaziert. Richten Sie das Koordinatensystem so aus,
daß die z-Achse mit der Achse der zylindrischen Form übereinstimmt.

� Zylindrisch (Cylindrical) — Für gerundete Objekte und Flächen. Wie bei der kugelförmigen
Plazierung wird die Textur relativ zu einem benutzerdefinierten Koordinatensystem plaziert.
Richten Sie das Koordinatensystem so aus, daß die z-Achse mit der Achse der zylindrischen Form
übereinstimmt.

6. Geben Sie die Anzahl der Kopien ein. Hiermit legen Sie fest, ob das Objekt oder die Fläche vollständig
mit Kopien des Texturmusters ausgefüllt werden soll. Bei mehreren Kopien wird die Textur
kachelförmig auf der Fläche angeordnet. Passen Sie die Größe der gekachelten Textur an. Legen Sie
hierzu einen Masstab (Scale) fest.

7. Ändern Sie die Ausrichtung der Textur mit Hilfe der Steuerungen im Dialogfenster Material-

Plazierung (Material Placement):
� Plazierung (Placement) — Zum Anpassen der Orientierung der Textur:

Horizontal und Vertikal (Vertical) — Abstand der Textur zum Ursprung (bei der anfänglichen
Plazierung). Zulässige Werte: -10 bis 100.
Rotieren (Rotate) — Drehung der Textur um den Ursprung. Zulässige Werte: -180 bis 180.

� Masstab (Scale) — Maßstab der Textur relativ zur Fläche bzw. zum Teil.

Breite (Width) — Horizontaler Maßstab relativ zum Ursprung. Zulässige Werte: 0 (Standard-
Maßstab) bis 10.
Hoehe (Height) — Vertikaler Maßstab relativ zum Ursprung. Zulässige Werte: 0 (Standard-
Maßstab) bis 10.

8. Richten Sie das Teil gemäß der ausgewählten Projektion aus. Bei der planaren Projektion wird der
Farbeffekt senkrecht zur Ansichtsebene auf das Teil oder die Fläche projiziert. Bei der sphärischen und
der zylindrischen Projektion wird das Teil an der z-Achse des Koordinatensystems ausgerichtet.
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9. Klicken Sie in der unteren linken Ecke des Dialogfensters Material-Plazierung (Material

Placement) auf OK. Die Textur wird plaziert.

So entfernen Sie Texturen

1. Klicken Sie auf die Schaltfläche Farbeffekt (Appearance) , oder wählen Sie die Befehlsfolge
Ansicht > Modelleinstellung > Farbe & Farbeffekte (View > Model Settings > Color &

Appearances).
2. Wählen Sie den Farbeffekt aus der Palette.
3. Mit Einstell rueck (Unset) heben Sie die Plazierung des Farbeffekts auf.
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